Have a try

Managing schedules (Date Book)

You can save the data and time of your schedule.

You can manage your schedules, such as conferences or business trips
efficiently.

» Application to be used: “Date Book”

+ Setting: Installed in your CLIE handheld

s For details, refer to “Date Book” in the “CLIE Application Manual” installed on your
computer.
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Entering a schedule

1 Press the ®@= button to start “Date Book.”
[Jan 1, s IR M BEBE

8:00
900
10:00
11:00
12:00
1:00
2:00
300
4:00
5:00
6:00

] (o) (o) (5o

Continued on next page
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2 Tap New and set the start time and end time of the

schedule.

[1] Tap to set the start time. f
[2] Tap to set the end time.
Tap to determine the settings. Stact. Times

[@] Tap to select “hour.” LT ] {

[8] Tap to select “minute.” 2} { }

@ Cancel ,

3 Enter a schedule.

“Tip
* For details of entering data, refer to “Entering
data” (page 25).

1

12:00

[m Meeting at the Conference room
200

3:00
4:00
5:00
6:00

] (o) (Gotale) (G 7)




Deleting a schedule

1 Tap a schedule you want to delete and press and hold the
Home ([)/Menu =7 button in the Date Book list screen.

The menu screen is displayed.

2 Tap Delete Event... from the Record menu.

The confirmation message is displayed.

3 Tap OK.

Tip

(LBl Edit Options

New Event <N
DeleteEvent.. - /D B

JAttachNote /A|"

|DeleteNote.. #O
<E

{Purge..

BeamEvent B J-ence room!
SendEvent .
SV
4:00

6:00

6:00

Details

Tap [] for Save archive copy on PCand checkit [/ inthe Delete Event
screen. Then the deleted data from your CLIE handheld is saved in your computer
when you synchronize your CLIE handheld with your computer wirelessly.
To see the saved data in your computer, open the Palm™ Desktop for CLIE
software, and select “Open the backup file” in the “File” menu of the “Date Book”

screen.
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Managing addresses and telephone numbers
(Address)

You can register Address information, such as name, address and telephone

number.

Also you can attach images or set to Name Card to send to the other CLIE

handheld or Palm OS compatible device by beaming.

» Application to be used: “Address”

+ Setting: Installed in your CLIE handheld

# For details, refer to “Address” in the “CLIE Application Manual” installed on your
computer 3

Entering a new address

1 press the \\ button to start “Address.”
2 Tap New.

'Address - Al
Sony Corpor H###-##¥-FH..W

.
Look Up: H -m

me—

3 Tap each item to enter details.

- Tip 'Address Edit {Unfiled

You can scroll the screen by tapping the A/¥
arrow in the bottom right-hand corner.

Nolmage

First name:
Title:,

ComEanﬁ:_
Done ] (Details.. ] { Note (g
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Deleting an address entry

1 Tap an address you want to delete and press and hold the
Home ([Y)/Menu =7 button.

The menu screen is displayed.

2 Tap Delete Address... from the Record menu.
The confirmation message is displayed.

N Deleta Address.. - D
*(Duplicate Address T
Beam Address i
Send Address

Dial... 4
Attach Note 7A
Delete Note.. 70

Select Business Card..
Beam Busineas Card

{ Record TN

Done Edit New

3 Tapok.

Tip.

Tap [] for Save archive copy on PCand check it [¥f in the Delete
Address screen. Then the deleted data from your CLIE handheld is saved in your
computer when you synchronize your CLIE handheld with your computer

wirelessly.

To view the saved data in your computer, open the Palm™ Desktop for CLIE
software, and select “Open the backup file” in the “File” menu of the “Address”
screen.

41

A1} e oneH

Exchanging Date Book and Address data
between your GLIE handheld and computer

HotSync® operation (page 35) enables you to exchange Date Book data and the
Address data between your CLIE handheld and computer.

Depending on the applications that you use on your computer, there are two
ways to exchange data.

Exchanging data between your CLIE
handheld and Palm™ Desktop for CLIE
software on your computer

You can synchronize data between “Date Book™ or “Address” managed by the

Palm™ Desktop for CLIE software on your computer and your CLIE

handheld.

+ Setting: You need to install “Palm™ Desktop for CLIE” in your computer.

s For details on how to exchange data with the Palm™ Desktop for CLIE software, refer
to “Synchronizing data between your CLIE handheld and computer (HotSync®)”
(page 35).

Exchanging data between your CLIE
handheld and Microsoft® Outlook
(Intellisync® Lite) in your computer

« Setting: You need to install “Intellisync Lite” in your computer.

s For details on how to install, refer to “Installing applications you want on your CLIE
handheld” (page 62).

Tip
Intellisync Lite can be installed with the option “Using your CLIE handheld” of the
installer menu screen.
# For details on how to start and setup, refer to the help of “Intellisync Lite.”
To view help, click Programs (In case of Windows XP, click All Programs) from
the Start menu at the left bottom of the screen, then click Intellisync Lite and
Intellisync Help.
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2 Copy the documents you want to the “Memory Stick”
media inserted in your CLIE handheld.
Use “Memory Stick Import” to transport documents to the “Memory Stick™
media inserted into the slot of your CLIE handheld.

it

Viewing computer documents on your CLIE
handheld (Picsel Viewer for CLIE)

You can view the documents created in Microsoft® Word, Excel, PowerPoint®

or PDF with your CLIE handheld.

+ Application to be used: “Picsel Viewer for CLIE”, “Memory Stick
Import” and “Memory Stick Export”

¢ Required media: “Memory Stick” media

< Data to be used: doc format, xIs format, ppt format, txt format, JPEG
format, GIF format, PNG format, BMP format, PDF format, HTML format
and MHTML format.

+ Setting: “Picsel Viewer for CLIE” is installed in your CLIE handheld.
“Memory Stick Import” is instalied in your CLIE handheld.
You need to install “Memory Stick Export” in your computer.

# For details, refer to “Picsel Viewer for CLIE” in the “CLIE Application Manual”
installed on your computer.

Connected toPC.
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Viewing the documents
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Transferring the documents to your CLIE
handheld

¢ icon in the CLIE Launcher
or CLIE.”
164

Watcome! Piesel Viswer lets you read
almest any dogurnent on scresh.

1 Select the Picsel Viewer
screen to star
100pm e
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1 Insert “Memory Stick” media into your CLIE handheld.

To mova through Jis dasument, ‘pan’

= For details on “Memory Stick” media, refer to
“Inserting/removing “Memory Stick” media” (page 93)
in “Sony CLIE™ handheld components.”

Continued on next page
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& cusoemo

£ Msimport
B vseadup
) CLEFies

tha page by tpuching and helding your
pon on the middle of the sereen, and
drawing umvards, ot in any direclion, To
2zoom o, tap tho micdle of the screon,
lat go and then quickly touch ang hold
FOUL e again and mave it up or dowrn,

You can viaw your own decuments by

tapping on the ‘Carouse! icon in the g
it ner o if &

2 Tap the Carousel @j, icon at the right bottom of the

screen.

The “Carousel” menu is displayed.

3 Tap the Folder View & icon, and then tap a document
you want in the “Memory Stick” media.
The document you wanted is displayed.



Recording a voice memo (Voice Recorder)

You can record voices using the built-in microphone of your CLIE handheld.

Also, you can use the voice memo as an alarm sound or attach it in an e-mail.

« Application to be used: “Voice Recorder” and “CLIE Viewer” (When
you play back the voice memo.)

+ Setting: “Voice Recorder” and “CLIE Viewer” are installed in your CLIE
handheld.

# For details, refer to “Voice Recorder” in the “CLIE Application Manual” installed on
your computer.

Recording a voice memo

1 select the Voice Rec icon in the CLIE Launcher screen
to start “Voice Rec”.

& oate Book
@ Topolist

€3 vemo pad

E3p cuEMemo

2 Press the REC button.

The recording starts. Speak REC LED

into the built-in microphone. Lights when
recording.
Tes. REC - Built-in
¢ Assoon as the REC button Press the <= microphone
is pressed, “Voice button.
Recorder” automatically S
starts and then recording
starts.

* There are two ways of recording for Voice Memo, “High” (To record at
meetings or in a quiet and/or spacious place) and “Low” (To record
dictation or in a noisy place).

% For detalils, refer to “Voice Recorder” in the “CLIE Application Manual” installed
on your computer.

3 Press the button once again to stop recording.
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Playing back a voice memo

You can play back a voice memo using “Voice Recorder” or “CLIE Viewer.

> For details about “Voice Recorder,” refer to “Voice Recorder” in the “CLIE
Application Manual” installed on your computer.

# For details about “CLIE Viewer,” refer to “Playing back handwriting memos, voice
memos or image files” on page 47.

2
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Playing hack handwriting memos, voice memos SelectingiDeleting files

or image files .
You can select a file from the list screen in “CLIE Viewer” when attaching
image files or movie files of your CLIE handheld to e-mails, when using the

You can use “CLIE Viewer” to view the image files or movie files and play
image files in “PhotoStand” (page 65), “CLIE Album” (page 64) and “Photo

back the voice memos or handwriting memos saved on your CLIE handheld.

Different kinds of file are displayed in the order of the date. It makes easier to Editor” (page 65), or when deleting files.

find the file you want to display or play back.

Also, you can attach image files or movie files to your message, or select the 1 Start “CLIE Viewer.”

data to use with applications, such as “PhotoStand”, “CLIE Album” or “Photo

Editor.” 2 Tap the command button to select the function.

@) : Select the file to be attached to an
e-mail
This icon is displayed if “CLIE Mail”

+ Setting: “CLIE Viewer” is installed in your CLIE handheld. is installed.
= For details on the file format you can play back or view with your CLIE handheld, ~ #7 " = : Select the image file to be used in
refer to “CLIE Viewer” in the “CLIE Application Manual” installed on your 5 “PhotoStand”

« Application to be used: “CLIE Viewer”
+ Files you can use: Image file, movie file, handwriting memo and voice
memo

computer. - : Select the file to be deleted
0000 0000000000000000000000000000000000000000000000000000 g :Selectotherapplicationssuchas
OpeningIPIaying back fi |es g “Photo Editor” or “CLIE Album” by using the pull-down menu
[y
1 . . < 3 Tap to select the check box of the file.

Select the CLIE Viewer @ icon in the CLIE Launcher

screen to start “CLIE Viewer."” Tip

The file list screen is disp}ayed. ) Tap Select All to select all the files.

1:00pm & T

QY cuE Album »
@ Protostand H

4 1ap ok

The function selected in step 1 is executed.

R Photo Editor
[ Movie pay
@ Fashpiayer

: - B
Eﬂ AudioPlayer

2 Rotate the Jog Dial™ navigator to select the file you want
to display and press the Jog Dial™ navigator.
The selected file is displayed or played back.

Tip

* You can also display the file by tapping the file icon.
» The files are listed in order of creation date and time.
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Take ima efiles or movie files created with .l.l..DQO.I:...I.....:.............:....-..I..-l..........
ther d v!.’ s with vour CLIE handheld Convert image files or movie files in
0 evice y different formats on your computer
You can play back image files or movie files created with other devices on your « Application to be used: “Image Converter” (for PC)
CLIE handheld using “Memory Stick” media. » Required media: “Memory Stick” media
Also, you can convert image files or movie files in the different formats on your « File formats for CLIE:
computer to play back in your CLIE handheld. — Image files: BMP format, JPEG(DCF) format, TIFF format, GIF format,

PNG format, PictureGear Pocket format
— Movie files: AVI format, MPEG Movie format, QuickTime format
For formats of picture that can be taken with your “Memory Stick”

I N EFENNERENNNNRENNNNENENEENEEEE NN ENE NN R AN NS R A NE N NN ENDE SN

Using your CLIE handheld to view image

= - - - "
fl Ies and movie fl Ies ta ken WIth Memory compliant devices, refer to their respective operating instructions.
= 2 - -
Stick 'Compl iant devices » Setting: You need to install “Image Converter” in your computer.
. Application to be used: “CLIE Viewer” & For details, refer to “Image Converter” in the “CLIE Application Manual” installed on
; your computer.

* Required media: “Memory Stick” media
« File formats for CLIE:
— Image files; JPEG(DCF) format, PictureGear Pocket format
— Movie files: Movie Player format, MPEG Movie format
For formats of picture that can be taken with your “Memory Stick”
compliant devices, refer to their respective operating instructions.
+ Setting: “CLIE Viewer” is installed in your CLIE handheld.

1 Start “Image Converter” on your computer, and convert
image files or movie files to the file format for CLIE.

A e aney

1 Insertthe “Memory Stick” media to which you have saved
image files and movie files in your CLIE handheld.
= For details on “Memory Stick” media,
refer to “Inserting/removing “Memory
Stick” media” (page 93) in “Sony CLIE™
handheld components.”

2 Transfer the converted image files or movie files to
“"Memory Stick” media.

3 Insert the “Memory Stick” media to your CLIE handheld
and start “CLIE Viewer"” to play back.

2 Start “CLIE Viewer” to view image files or movie files.
# For details, refer to “Playing back handwriting memos, voice memos or image
files” on page 47.
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Take music with you

You can listen to the music on your CLIE handheld by transferring the music
file from your computer to your CLIE handheld.
« Data you can use (format): ATRAC3, MP3
* Required media: Headphones (¢3.5 stereo mini jack), “Memory Stick”
- media
« Application to be used:
— Transfer music file in ATRACS3 format: “SonicStage” (for PC)
— Transfer music file in MP3 format: “Memory Stick Import”, “Memory
Stick Export” (for PC)
— Play back music file on your CLIE handheld: “Audio Player”
« Setting: “Audio Player” “Memory Stick Import” are installed in your
CLIE handheld.
You need to install “SonicStage”, “Memory Stick Export” in your computer.

%+ For details, refer to “Music” in the “CLIE Application Manual” installed on your
computer.

Transfer music files to your CLIE handheld

You can transfer music files you want using “SonicStage” or “Memory Stick
Export” from your computer to your CLIE handheld.

“Tip e =
You can also convert music in the CD on your
computer to play back on your CLIE handheld.

XL
o
<
(1]
v
[
<
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Playing back music data

1 Connect the headphones (optional) to the CLIE handheld.

:Tip
Your CLIE handheld has a stereo mini jack.

2 Select the AudioPlayer &L
icon in the CLIE Launcher
screen to start “Audio Player.”

Voice Rec

% Sound VUl

£ Date Book
@ TovoList

4 vemo pad

3 Tap the playback f&::;) button to
play music.
Tap the stop () button to stop the
music.

Playback ~

e Stop
button button
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Using the Bluetooth™ function

The Bluetooth™ function is a new technology to enable wireless
communication for mobile phones, computers or other mobile devices.

The Bluetooth™ built-in CLIE enables wireless communication within arange
or approximately 10 meters?. You can use the function to exchange data such
as image files between your CLIE handheld and other Bluetooth compliant

devices.

What you can do with the Bluetooth™ function

# Exchanging data such as image files or Date Book
data with another CLIE handheld?®

wirelessly?

- Synchronize your CLIE handheld with a computer

 Operating a digital still camera? or camcorder?

from the CLIE handheld remotely

\ ) (e Ezﬂﬁ

Continued on next page
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I Connecting to the Internet via a mobile phone?

W
1) The actual range will vary depending on factors such as obstacles between devices,
magnetic fields around a microwave oven, static electricity, interference, radio wave
conditions, reception sensitivity or antenna performance, and the operating system or
software application, etc.
2) The Bluetooth™ function is required for the target devices. For information on the
compliant devices, refer to your Sony CLIE handheld support website:
Customers in the U.S.A., Canada and Mexico:
http://www.ita.sel.sony.com/support/clie/
Customers in Asia-Pacific Countries:
http://vaio-online.sony.com/clie/

« Setting: To use the Bluetooth™ function, select Bluetooth in the
Preferences screen and set to Enabled for the Bluetooth item.

Setting the Bluetooth function to Enabled/Disabled

Preferencas B Biustooth |

| Buttons
Set Date: ; 1/{Connection
Set Time:

& sewny Set Time Zone:
@ cadinfo ! Daylight Saving:

@ wotsync

g Wekome H ShortCuts

3 cUEAbum s

Select “Prefs” in the Tap V¥ on the right top on the
CLIE Launcher screen screen to select Bluetooth

[ Praterences] v Bluetooth
Bluetooth: v Enabled \&m——-« Select Enabled
or Disabled

Device Name:

Allow Device to
be Discovered: ¥ Yes

Allow WakeUp: ¥ No

Device Addrass: 00:60:57:04:16:CA

Trusted Devices




e ~Bluetooth Exchanging data such as image files or Date

antenna -
Book data with another CLIE handheld
Bluetooth LED
The LED lights up during data | Note |
exchange using the Bluetooth™ This functi b d di di h li
function. 18 function may not be use epending on where you live,
It blinks when the function is on
standby. 1 select a file.

* For details, refer to “Customizing your Sony CLIE™ handheld (Preferences): Setting Sending an image file, movie file, voice
the Bluetooth™ function” in the “Handbook.” memao, or handwritten memo

Start CLIE Viewer (page 47),

m press and hold the Home @/
* The communication performance is decreased if the antenna comes in contact with a Menu ::h button to display
metal object. 7 the menu screen, select
Place your CLIE handheld in the cradle when you use your CLIE handheld on ametal  / Send... from the Data menu
table. . ;
* Avoid covering the antenna with hands while using the Bluetooth™ function. and tap a file you want to send.
Otherwise radio reception may be interrupted.

_Tip

Sending image files
You can select a method of sending data in the Send With dialog box.
(The dialog box below may not be displayed depending on your operating
environment)

A1} e aney

Biuetooth (BIP)

SMS

Example of a sending method
Bluetooth (BIP): This is to send an optimized file for the target devices.

+ Install Remote Camera to display Bluetooth (BIP).
» Remote Camera is not on sale in some location.
w3 For details, refer to “CLIE Application Manual” installed on your computer.

> sending Date Book data or Address data
Tap schedule data or address data you want to send, press and hold the
Home @/Menu E]T button to display the menu screen, and then
select Send Event (for “Date Book™) or Send Address (for
“Address”) from the menu.
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2 Send a file.
After the Bluetooth Discovery dialog box is displayed, the list of

Synchronize your CLIE handheld with a

Bluetooth compatible CLIE handhelds within a range of the computer erEIESSIy

communication area is displayed on the Discovery Results dialog box.
Tap to select a CLIE handheld to which you want to send data.

Discovery Results €

Select one or more devices:

[&cie

Bluatooth Discovery.

@ Preparing.. »

(oK )(Cancel) (FindMore )

The Bluetooth Progress dialog box will be displayed on both CLIE
handhelds. Follow the on-screen instructions.

If you are using a Bluetooth compatible computer, you can wirelessly
synchronize information, such as calendars, contacts and tasks, between your
CLIE handheld and a computer without connecting the cradle to the computer.
= For details, refer to “Exchanging and updating data using a HotSync® operation
(Other HotSync® operations): Performing a HotSync® operation using the
Bluetooth™ function” in the “Handbook.”
% For information on the compliant devices, refer to your Sony CLIE handheld support
website:
Customers in the U.S.A., Canada and Mexico:
http://www.ita.sel.sony.com/support/clie/
Customers in Asia-Pacific Countries:
http://vaio-online.sony.com/clie/

P00 0000 PPN OINOOPORIONBIROIPIPTRERNONOOOROEPOEPNOEOIBPIOISTITTNRTS

Operating a digital still camera or
camcorder from the CLIE handheld remotely

Tip - -
If you have renamed a target Bluetooth™ compatible device registered on CLIE 2 m
handheld, the device may be listed in the previous name when you detect target : " . . .
Bluetooth™ compatible devices. - This function may not be used depending on where you live.
In this case, follow the procedure below. < You can remotely control and capture images on a Bluetooth BIP compatible
(@ Open the setting screen of the Bluetooth (page 54) and press and hold the Home digital still camera (DSC-FX77)* and camcorder (DCR-TRV80 or DCR-
m Menu ZJ| button. . TRVSOE)* with using your CLIE handheld.
® Tap Disable device name cache from the Options menu. . o e - "
® Detect target Bluetooth™ compatible devices. = For details, refer to F]LIE Apphcé.mon Manual” installed on your computer.
* They are not on sale in some location.
m A AR AR NN N ENE RN ENENE AR ENEREENENNEEEENENENNNEENNEREENREENENENNENENNENNHNHN )
To view or edit received data/files, applications supporting each data/file must be Connectl ng tO the Internet via a mObl Ie
installed on the CLIE handheld. ph one

Playing games with another CLIE handheld

You can enjoy playing games with another CLIE handheld with the built-in

Bluetooth device or installed the Bluetooth module. To play the game, install

the game called “Reversi” in the both CLIE.

% For details, refer to “Reversi” in the “CLIE Application Manual” installed on your
computer.
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You can browse websites or exchange e-mails by using the Bluetooth

compatible mobile phones.

* Necessary device: Bluetooth compatible mobile phones

* Application to use:

— To browse websites: “NetFront v3.0 for CLIE” (page 71)
— To exchange e-mails: “CLIE Mail” (page 70)

* Setting: You have to install “NetFront v3.0 for CLIE” and “CLIE Mail” in
your CLIE handheld. You have to be a member of an internet service
provider in advance. You have to set the connecting methods, register your
mobile phone to use or set the network.

#» For details, refer to “Connecting to the Internet by communicating with Bluetooth
built-in mobile phone” in the “Handbook.”



Connecting to the Internet
[ Note |

For an internet connection, you must have acommunication device that is compliant with

your CLIE handheld, and you must be registered with an Internet Service Provider.

# For connecting to the Internet using the Bluetooth™ function, refer to “Using the
Bluetooth™ function”: “Connecting to the Internet via a mobile phone” (page 58).

Installing applications in your CLIE
handheld

Install applications on your CLIE handheld for your purposes.

Browsing websites on your CLIE handheld: NetFront v3.0 for CLIE (page 71)

Exchanging e-mail: CLIE Mail (page 70)

% For details about the necessary set-up of each application, refer to the “CLIE
Application Manual” installed on your computer.

Connecting to the Internet

A1y e oAl

1 Connect a communication device (optional) with your
CLIE handheld.

2 Select the desired application in “CLIE Launcher” and
start it.

3 Start browsing websites, sending and receiving e-mail.
Internet connection starts automatically.

Tip
When you want to attach image files or movie files from your CLIE handheld to an

e-mail, you can select those files from the list displayed in “CLIE Viewer.”
% For details, refer to “Selecting/Deleting files” (page 48).
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Using applications

This chapter describes how to use add-on applications and the “CLIE Application Manual.”

For details about add-on applications, refer to the manuals for each add-on application.

About add-on applications

Applications are divided into three types as follows:

» Applications already installed on your CLIE handheld

* Applications you need to install on your CLIE handheld
For details about using the Installation CD-ROM, follow the procedure on
page 62.

» Applications you need to install on your computer

Using CLIE Application Manual

For details about using the add-on applications, refer to the “CLIE Application
Manual” installed on your computer.

¢ Prior to using applications, refer to “Install the software on your computer” on page
29 to install the Palm™ Desktop for CLIE software. The “CLIE Application Manual”
will be installed at the same time.

+ The “CLIE Application Manual” requires “Microsoft Internet Explorer Version 5.0”
or later to be displayed properly.
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Installing applications you want on your cué

Opening CLIE Application Manual
handheld

1 Double-click the CLIE info icon on the Windows desktop. You can install applications with the supplied Installation CD-ROM by
“CLIE info” window is displayed. following procedures below.

2 | h | by followi h Install the Palm™ Desktop for CLIE software on your computer in advance
_Se ect t_ e manual by Tollowing the on-screen with the supplied Installation CD-ROM and connect the cradle to your
instructions. computer

Tips | Note |

+ To close the “CLIE Application Manual,” click the icon in the top right-hand The add-on applications are designed to operate on this CLIE handheld only.

corner of the CLIE Application Manual window. i Compatibility with other CLIE handheld or Palm OS PDAs is not guaranteed.

* You can minimize the CLIE Application Manual window by clicking the -

the top right-hand corner in the window. The minimized window can be reopened by $ 50000000 000000000000000000C0GC0GC0000C00000000000EEEIBROI0TSS
clicking the CLIE Application Manual button in the task bar. Installi ng with the su ppl ied | nstal lation

* You can operate other software while the CLIE Application Manual window is

displayed on the Windows desktop. CD"ROM

* You can also view manual directly from the installation CD-ROM.
1 Insert the CD-ROM.
2 Click “Manual” button.
3 Click “View” of “View Manuals.”

1 Quit all applications running on your computer.

2 Insert the Installation CD-ROM into the CD-ROM drive of

your computer.
The installation launcher window appears.

Click CLIE Desktop.
Click Install to the right of CLIE Add-ons.

suonedyjdde Buisn

Select the add-on applications to install.
Click Next.

Select the User.

Click OK.

Click Done.

O O oo ~NO” O AW

-t

To install the application on your CLIE handheld, press
the HotSync button on the cradle.

The HotSync starts and the selected application is forwarded to your CLIE
handheld.
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You can also install applications on your CLIE handheld with the Palm™ Desktop for

CLIE software.
% For details, refer to “Enhancing features with add-on applications: Installing:
Installing from your computer” in the “Handbook.”
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Introducing add-on applications

In this section, you can see add-on applications for your CLIE handheld in the
order of the group of “CLIE Launcher.”

# For details on the CLIE Launcher group, refer to “Using CLIE Launcher” in the
“Handbook.”

| General

@ Viewing/Playing back a file after
searching from the list

% Application to be used
CLIE Viewer | CLIE handheld

#» Summary
For managing and displaying image files, movie files, handwriting memos and Voice memo files.

#» Preparation for use:

# For details, refer to the “CLIE Application Manual” installed on your computer.

Picture __|

Managing image files in albums

&5 Application to be used

CLIE Album

reen helmats lock wall?

_— ot
% Sum mary ur dream io te ke a profecsional baze

E

oullpluyer.

For managing image files saved on your CLIE handheld or “Memory
Stick” media, in an album format.

You can use image files in albums with your computer linking up with “PictureGear Studio
for PC software.

7@ Preparation for use:

4 For details, refer to the “CLIE Application Manual” installed on your computer.

3
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Displaying image files automatically
2 Application to be used

PhotoStand

% Keyword
JPEG (DCF) format

: Summary
For displaying automatically image files one after the other.

- Preparation for use:

s For details, refer to the “CLIE Application Manual” installed on your computer.

%8 Editing images
#» Application to be used

Photo Editor

¥ Keyword
JPEG (DCF) format

: Summary
For drawing pictures on an image file. You can also draw pictures on a new blank canvas.

- Preparation for use:

= For details, refer to the “CLIE Application Manual” installed on your computer.
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Importing image/movie files from
your computer

i Application to be used
Image Converter

# Keyword
JPEG (DCF) format, Movie Player format

% Summary
You can convert images and movies to the format on your computer and you can view them
on your CLIE handheld.

% Preparation for use: [N §-CANSENER | Requires a “Memory Stick”

## Installation CD-ROM Menu
“CLIE Image”

% For details, refer to the “CLIE Application Manual” installed on your computer.

Importing albums and binders to your
computer

%3 Application to be used
PictureGear Studio

{#» Summary
What you can do with using PictureGear Studio:
+ Create albums and binders on your computer and import binders to your CLIE handheld.
« Import images on your computer and manage them.
* Print out labels.

2 Preparation for use: QU WS EI LN | Requires a “Memory Stick”

% Installation CD-ROM Menu
“CLIE Image”

s For details, refer to the “CLIE Application Manual” installed on your computer.
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| Movie

: Playing back movies

#: Application to be used

Movie Player | CLIE handheld

Keyword

Movie Player format (movie formats shot with CLIE handhelds with
the built-in camera or converted using the Image Converter software), www.aibo.com
MPEG Movie format (MPEGI format movie files shot with a Sony

Digital Still Camera or Handycam), Play List, Repeat function, and Index function.

# Summary
For playing back movies recorded with the CLIE handheld with the built-in camera or playing
back movies on your CLIE handheld using “Image Converter” or “Giga Pocket Plugin” on
your computer.

& Preparation for use:

Installed || Requires a “Memory Stick”|

+ For details, refer to the “CLIE Application Manual” installed on your computer.

@ Playing back Macromedia® Flash™

Application to be used c

- w
Macromedia Flash Player 5 5
@

CLIE handheld P

% Keyword %
swf format E't

=

3

w

i% Summary
For playing back the Macromedia Flash contents.
Some Flash contents for computers may not be played back normally on your CLIE handheld.

7 Preparation for use: Requires a “Memory Stick?|

« For details, refer to the “CLIE Application Manual” installed on your computer.
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Importing movie files from your
computer

This function may not be used depending on where you live.

#5 Application to be used
Giga Pocket Plugin

% For details, refer to “CLIE Application Manual” installed on your computer.

# Keyword
Movie Player format

% Summary
For converting the formats of movie files on your computer so that they can be viewed on
your CLIE handheld.
You need to install “Giga Pocket” for VAIO application on your computer.

i3 Preparation for use: JUIIS & IR £ | Requires a “Memory Stick”|

# Installation CD-ROM Menu
“CLIE Image”

% For details, refer to Help files of the “Giga Pocket Plugin” installed on your computer.

Music/Sound
Listening to music with your CLIE ==
handheld S
7% Application to be used

Audio Player

: Keyword
MP3, ATRAC3

Summary
For playing back music files saved on a “Memory Stick” media.

{® Preparation for use:| Installed

Needs to be connected to your computer J
Requires a “Memory Stick” and headphorﬁs_}
# For details, refer to the “CLIE Application Manual” installed on your computer.

1
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&% Recording voice memo
i+ Application to be used

Voice Recorder | CLIE handheld

1% Summary
For recording and playing back a voice memo using the built-in
microphone of your CLIE handheld.

#» Preparation for use:

+ For details, refer to the “CLIE Application Manual” installed on your computer.
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@ Customizing the sound settings

: Application to be used Fareon |
‘re Aepors s
Sound Utility | CLIE handheld B
bt b

> Summary

{(Dolato){ Rename ) (Repent OFF)

For managing the audio data converted with Sound Converter 2. The

audio data files are transferred from your computer to your CLIE handheld via a HotSync®
operation.

i Preparation for use: [ Installed
‘Needs to be connected to your computer

% For details, refer to the “CLIE Application Manual” installed on your computer,
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Transferring music files to your CLIE
handheld

i3 Application to be used
SonicStage :

+ Keyword
ATRAC3

ey

& Summary

For managing and creating music files to be played back with your CLIE handheld in your
computer.

The application is also used for transferring music files to a “Memory Stick” media.

s Preparation for use: §IES § X 1L

4% Installation CD-ROM Menu
“CLIE Audio”

«> For details, refer to the “CLIE Application Manual” and Help files of “SonicStage” installed on your
computer,
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Sending audio data to your CLIE
handheld

i@ Application to be used
Sound Converter 2

§5 Keyword
WAVE (PCM) format, MIDI (Standard MIDI File Format 0/1) format

% Summary
For converting the audio data of WAVE (PCM) format or MIDI format in your computer to
audio data of the CLIE handheld format.

% Preparation for use: ¥ - R S

% Installation CD-ROM Menu
“CLIE Utilities”

# For details, refer to the “CLIE Application Manual” installed on your computer.

Internet

RN~ Outbox]

= diegzony Moeting  1/1210..

3, Sending and receiving e-mail
messages

i Application to be used
CLIE Mail | CLIE handheld

# Summary
For sending and receiving e-mail messages on your CLIE handheld.

#» Preparation for use: SIS EUES

#5 Installation CD-ROM Menu
“CLIE Desktop” - “CLIE Add-ons”

s For details, refer to the “CLIE Application Manual” installed on your computer.
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W Browsing websites

#: Application to be used

NetFront v3.0 for CLIE

Keyword
Websites, Internet, WWW browser

# Summary
For browsing websites with your CLIE handheld.

i Preparation for use: S {ANEEE

2 Installation CD-ROM Menu
“CLIE Desktop” ~ “CLIE Add-ons”

s> For details, refer to the “CLIE Application Manual” installed on your computer.

Organizer

£ Managing addresses and
telephone numbers

1 Application to be used

Address | CLIE handheld

Addresy: - Al
Sony Corpor FHF-FHF-FH.W

Summary

For entering and editing Address information such as names, addresses or telephone numbers.

4 Preparation for use:

«» For details, refer to the “CLIE Application Manual” instatled on your computer.
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» Managing schedules and events

Application to be used
Date Book | CLIE handheld

% Summary

For managing schedules and events such as meetings or business trips.

Preparation for use:

s For details, refer to the “CLIE Application Manual” installed on your computer.
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2 Managing tasks and things to do

(SR O —

i Application to be used

To Do List

# Summary
For displaying tasks that you want to be reminded of Jater. You can
assign priority to any task.

% Preparation for use:

# For details, refer to the “CLIE Application Manual” installed on your computer.
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4 Taking memos

1. Sony Cerporation & #-F# F-...

i Application to be used
Memo Pad | CLIE handheld

# Summary
For taking memos or displaying documents created on your computer.

# Preparation for use:

= For details, refer to the “CLIE Application Manual” installed on your computer.

£y Taking handwritten memos using
the stylus
#» Application to be used

CLIE Memo | CLIE handheld

i Summary
For taking handwritten memos using the stylus.

i Preparation for use:

s For details, refer to the “CLIE Application Manual” installed on your computer.

Using the calculator
i Application to be used

Calculator | CLIE handheld

{#% Summary
For calculating with your CLIE handheld. You can save and recall
calculations with the calculator’s memory.

% Preparation for use:

% For details, refer to the “CLIE Application Manual” installed on your computer.
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